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Micro Focus Enterprise Developer 2.3
Update 1 for Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

• Micro Focus Enterprise Developer Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is suitable for anyone
who wants to become familiar with the Eclipse or Visual Studio means of editing and compiling
mainframe applications under Windows.

• Micro Focus Enterprise Developer Connect

Enterprise Developer Connect is for customers looking to use modern and productive Eclipse-based
tooling to develop mainframe applications directly on the mainframe. Close integration to mainframe
configuration management systems and the ability to easily customize the Eclipse-based IDE to include
mainframe-based tools and processes means developers can take full advantage of modern
development tools without having to learn new development processes.

• Micro Focus Enterprise Developer

Enterprise Developer is for customers looking to develop and modernize mainframe applications in a
productive and modern Windows-based development environment, targeted for deployment onto an
alternate server platform. Developers have the choice of either the Visual Studio or the Eclipse-based
IDE and development and test tools are provided for all target environments currently supported by
Micro Focus.

• Micro Focus Enterprise Developer for IBM zEnterprise

Enterprise Developer for IBM zEnterprise gives customers the choice to develop directly on the
mainframe or under Windows. Mainframe applications can be developed, maintained and modernized
regardless of where they will be deployed, either back onto the mainframe or onto an alternative server
environment. Support is provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro Focus - including
z/Linux, AIX and x86 environments.

Enterprise Developer for IBM zEnterprise combines all the capabilities of Enterprise Developer Connect
and Enterprise Developer.
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Full mainframe integration and the Application Workflow Manager are only available in the Eclipse-
based IDE.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer in the product Help.
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What's New
This release provides enhancements in the following areas:

• Integration with Visual Studio
• Application Server JCA support for Enterprise Server
• Code analysis
• Code coverage
• Compiler directives
• Enterprise Server
• Enterprise Server with .NET
• Data File Tools
• Database Access - HCO for SQL Server
• Database Access - Mainframe Batch Database Tools (MBDTs)
• Database Access - OpenESQL
• Database Access - SQL Option for DB2
• Dialog System applications
• Editor writing assistance
• Enterprise COBOL 5.2
• File Handling
• iFileshare - Fileshare under Enterprise Server (Early Adopter Product)
• Library routines
• Mainframe support and emulation
• Micro Focus Unit Testing Framework
• Managed COBOL syntax
• Native COBOL syntax
• PL/I support
• Rosetta Stone for COBOL, .NET and Java Developers
• Windows Azure

Integration with Visual Studio

Back to Top

Support for COBOL in Visual Studio has been enhanced in the following areas:

• The Go To location and Go To Procedure Division commands are now available from the Edit menu.
In addition, the Go To Procedure Division has a shortcut key - Ctrl+K, Ctrl+J.

• Object Browser - now provides support for .NET COBOL code. You can view the members of objects in
your project and the definition of classes and methods as specified by the XML documentation
comments in your code. The window also provides support for the Go To Definition command.

• A new search option, Current COBOL Program, has been added to the Find in Files dialog box. This
enables you to search in the COBOL program currently opened in the editor and in any copybooks
referenced by that program.

• Solution Explorer - a new context menu command, Add Folder to Copybook Paths, is now available
for the subfolders of your projects. This enables you to add the subfolders to the copybook path of the
project. For Mainframe Subsystem Projects, similar commands, Add Folder to Assembler Macro
Paths and Add Folder to IMS Copy Paths, are now available to help add subfolders that include
Assembler macro paths or IMS copy file to the Dependency Paths of the project.

COBOL editor:
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• Line numbers - a new option for configuring the increment for the COBOL and the standard line
numbers when you use Renumber and Unnumber has been added. You can specify the increment from
Tools > Options > Text Editor > Micro Focus COBOL > Line Numbering.

• Outlining - a new IDE option enables you to switch outlining in the COBOL editor on or off. See the
Enable Outlining option available on the Advanced page in Tools > Options > Text Editor > Micro
Focus COBOL.

• Program breakpoints - a new context menu command, Add COBOL Program Breakpoint, enables you
to set program breakpoints directly from the editor.

There are new options and new configuration pages in the IDE preferences:

• Autocorrect - a new preferences page in Tools > Options > Text Editor > Micro Focus COBOL.
• Quick Actions- a new preferences page in Tools > Options > Text Editor > Micro Focus COBOL

(Visual Studio 2015 only).

Debugging:

• It is now possible to examine object reference data items as you are debugging native Object Oriented
COBOL applications. The debug tooltip now displays the object's instance data provided that the debug
information for the object's class is available.

Application Server JCA support for Enterprise Server

Back to Top

This release provides support for:

• Automatic connection recovery to an active Java application server when an enterprise server region is
restarted. This applies to:

• COBOL resource adapters
• CICS resource adapters
• All CICS API based programs

• The IBM implementation of CICS resource adapter for WebSphere 8.5 and JBoss 7.1.1.

Code analysis

Back to Top

This release provides support for performing code analysis at the command line using Microsoft's MSBuild
utility which enables the integration of code analysis in CI frameworks.

Support is available for various MSBuild parameters. You can use MSBuild with the /p switch and with the
following Micro Focus-specific command line options:

• • RunMicroFocusCodeAnalysisAfterBuild - controls whether code analysis is performed with
MSBuild or not regardless of what code analysis options are specified the project's properties.

• ActiveRulesets - specifies which rule sets should be used when running code analysis from the
command line.

Code coverage

Back to Top

The code coverage reports are now integrated with the IDE and with the editor. Features include:

• A new Code Coverage window showing the statistics of what percentage of the code has executed.
• Navigation from the Code Coverage window to the missed and covered blocks in the editor.
• Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).
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Compiler directives

Back to Top

The following Compiler directives contain new parameters in this release:

• ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.

• OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in
your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it.

Data File Tools

Back to Top

This release provides improved security and increased support for more file types. Features include:

• Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

• When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

• Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - HCO for SQL Server

Back to Top

This release provides the following new features:

• End-to-end demonstrations that show several methods for submitting a JCL batch job that calls COBOL
stored procedures. To view these demos, see the SQL demonstrations in the Mainframe Samples
browser.

• The SPCALLLOCAL SQL compiler directive option, used to convert an EXEC SQL CALL into a call to a
local COBOL subroutine instead of a call to a SQL Server SQLCLR stored procedure.

• Extended support for conversion of the DB2 CONCAT function.

Database Access - Mainframe Batch Database Tools (MBDTs)

Back to Top

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.

This release provides MBDTs support for DB2 LUW partitioned tables.

Database Access - OpenESQL

Back to Top

This release provides the following new features:

• Demonstrations for using OpenESQL in .NET applications. To view these demos, see the SQL
demonstrations in the Visual COBOL Samples browser.

• Support for the Oracle fully managed ODP.NET driver.
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Database Access - SQL Option for DB2

Back to Top

This release provides the following new features:

• Import/export of XML with SQLWizard/DSNUTILB(XUTLB)
• New XDBSetup utility for TS/Citrix environments
• Using Migrate to move XML tables from z/OS DB2 to XDB
• Support for Temporal Tables

Dialog System applications

Back to Top

The version of the Compatibility AddPack for Visual COBOL released with Enterprise Developer 2.3
Update 1 enables you to give your Dialog System applications a refreshed user interface. Features include:

• Support for a modern look and feel for Dialog System applications.

Dialog System now supports Microsoft's visual styles for controls and fonts to give your existing Dialog
System applications a modern look that is native to the Windows version the applications are running
on.

You use a new environment variable, MFVSSW, to switch the visual styles on. Alternatively, for
applications that compile to an executable, to switch the new styles, you can add an application manifest
file to the applications' project files.

See the section Modernizing Dialog System Applications in your product help for details on how to
enable the visual styles, and for information about any possible changes in behavior or appearance of
the common controls.

• A modern look and feel of the Dialog System painter.

There are new configuration options in the Dialog System painter for applying the visual styles and fonts
to the painter.

• Visual Studio project templates for creating Dialog System applications with a modern look out-of-the
box.

The Compatibility AddPack for Visual COBOL now installs the following new project templates:

• Dialog System Application (Modern) for creating Dialog System applications that use Microsoft's
visual styles by default.

• Dialog System Application (Classic) for creating Dialog System applications that use the classic
fonts and look.

• Additional samples:

All of the Dialog System samples previously available with Net Express are now included with the
Compatibility AddPack for Visual COBOL. The samples have been converted to Visual Studio solutions.

For more information see the section Modernizing Dialog System Applications in your product help and the
Release Notes for the Compatibility AddPack for Visual COBOL.

Visual Studio editor coding assistance

Back to Top

This release includes various improvements in the IntelliSense support for COBOL in the following areas:

• Native COBOL - support is now available for OCCURS statements
• Managed COBOL - suggestions are now available in the working storage section and in the following

scenarios:

• Arithmetic expressions in method arguments
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• Casting variables and some expressions
• Creating arrays using the TABLE OF expression and indexers
• Generics
• Implements and inherits
• Type name filtering in constructs and attributes
• Managed type headers, method heathers and index headers.
• Nested types
• Signature help (Visual Studio)
• SIZE OF expressions
• String concatenations
• TYPE OF constructs
• Unqualified members access - using the SELF:: or SUPER:: syntax

• Support for float literals has been enhanced.
• Suggestions are now available for more COBOL verbs such as TRY and RAISE (in managed COBOL)

and EXAMINE, INSPECT, SEARCH, GO TO, INITIALIZE, INVOKE, and UNLOCK (in native COBOL).
• There are new IDE configuration settings for inserting suggestions and for case handling.

In addition, the Visual Studio editor provides the following new features:

•
• AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You

use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version.

• Light bulbs support in Visual Studio 2015 - there are new quick actions using the light bulb feature that
help you quickly change in the following scenarios:

• Convert to COBOL Syntax - offers to convert a .NET type to its equivalent COBOL predefined type.
For example, this will offer an option to convert System.UInt64 to binary-double unsigned.
Converting .NET types to the COBOL predefined types helps you write platform independent
applications which you can easily export from Visual Studio and edit with Enterprise Developer for
Eclipse.

This quick action is only available for managed COBOL code in the standard or the expanded
copybook view (if it is not in the read-only mode). It is not available in standalone copybooks.

• Extract to Copybook - takes the code you have selected in the editor and moves it to a new
copybook file in your project.

• Simplify name Type - enables you to simplify the names of .NET types by removing the fully
qualified namespaces when the simplified name can be resolved without ambiguity. For example,
you can change System.String to String.

Enterprise COBOL 5.2

Back to Top

With the introduction of Enterprise COBOL 5.2, the following features are supported:

• The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.

• Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.

• The SUPPRESS clause of the XML GENERATE statement has been enhanced.
• The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

Enterprise Server

Back to Top
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This release provides support for the SO_RCVTIMEO and SO_SNDTIMEO timeout options of EZASOKET
support that help reduce the risk of applications becoming unresponsive due to EZASOKET APIs not
completing.

Enterprise Server with .NET

Back to Top

Enhancements are available in the following areas:

• Support is provided for DSNRLI, the language interface load module for the DB2 Resource Recovery
Services attachment facility (RRSAF). The interface to RRSAF is only through the DSNRLI entry point
which provides explicit service connection requests for any XA resource, including WebSphere MQ.

• HSF support has been extended and is now available in JES regions.
• The EXEC CICS POST and WAIT API's are now implemented.
• Support for EZASOKET is now available in both CICS and JES regions.
• SQL API diagnostic events are now being recorded and displayed in the local trace tables.

File Handling

Back to Top

The following enhancements have been made to file handling processes:

• A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

• Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

iFileshare - Fileshare support under Enterprise Server (Early Adopter Product)

Back to Top

Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers.

Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.

If Enterprise Server work is being hosted on the primary region within the group, the setup must be
consistent on all standby Fileshare hosting regions so that work can continue in the event of a failover.

Library routines

Back to Top

The following library routines are new in this release:

• CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
• CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.
• PC_PRINTER_INFO_DOTNET (.NET COBOL only) - enables the access to the native Hdc for a printer.
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Mainframe support and emulation

Back to Top

This release provides the following enhancements:

• Enterprise Developer includes a new utility, MFJPTPCH, that emulates the IEBPTPCH mainframe utility
for printing or punching datasets.

• Support for using multiple catalog files (up to 32).
• Support for storing the spool files in a location that differs from the location of the catalog file.
• Enhanced support for searching the catalog using wildcards.

Micro Focus Unit Testing Framework

Back to Top

This release provides the following enhancements:

• Updates to the test runner command line options:

• Using the -testcases: option, you can now specify a list of test cases to execute.
• The new -report:markdown option enables you to produce test reports in github style markdown

format (.md).

You can use various Third-Party utilities such as pandoc to convert .md files into HTML or PDF
format.

• Support for running test suites using dynamic metadata - you use an entry point in the test case and,
when it is called during the preparation stage of the test case, you can change various fields exposed
through mfunit.cpy to update the metadata of the test case.

This is an alternative to specifying metadata for a test case in the text fixture file (.mfu).
• Support is now available for creating and debugging test cases written in procedural managed COBOL

(procedural code compiled as managed). The following new test runners are supplied:

• mfurunil, for .NET COBOL code
• mfurunj and cobmfurunj for JVM COBOL code.

Managed COBOL syntax

Back to Top

The following enhancements have been made to the managed COBOL syntax:

• You can now create generic iterators.
• You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed

COBOL applications.

Native COBOL Syntax

Back to Top

The following items are new features of the native COBOL syntax:

Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.

PL/I support

Back to Top

Support is available for the following features:
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• FIXED BIN(63) data type - PL/I programs that utilize FIXED BIN data types that are larger than FIXED
BIN(31) are now supported which enables you to migrate such programs more easily to distributed
platforms.

• TRIM() built-in functions - the Open PL/I macro preprocessor now supports the TRIM() built-in function.
• A 64-bit Open PL/I peephole optimizer - when compiling 64-bit Open PL/I programs optimization for

speed, a peephole optimizer is now run against the intermediate code to improve your applications'
performance. Any code which has attributes that benefit from peephole optimizations will then run
faster.

Rosetta Stone for COBOL, .NET and Java Developers

Back to Top

The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.

Windows Azure

Back to Top

Enterprise Developer support on Microsoft Azure has been updated to version 2.8 of the Microsoft Azure
SDK.

Important:

• Starting with this release, versions of the Microsoft Azure SDK earlier than version 2.8 are no
longer supported.

• Support for the Microsoft Azure SDK is no longer provided in Enterprise Developer for Visual
Studio 2012. If you have COBOL Azure projects created with earlier versions of Enterprise
Developer for Visual Studio 2012, to maintain them, use Enterprise Developer for Visual Studio
2013 or 2015.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Communications Server
• Data Tools
• Dialog System
• Editor Writing Assistance
• Enterprise Server
• IBM Language Environment for OS/390 & VM Support
• JCL Support
• Run-Time System
• SQL: OpenESQL
• SQL Option for DB2

Communications Server

Back to the list

• A new option, [Operation] synchronous=yes (or 1, or Yes, or y or Y) is now supported in the
Fileshare listener configuration.

Data Tools

Back to the list

• When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.

• The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.

• The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.

• The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Dialog System

Back to the list

• Versions of the Micro Focus Compatibility AddPack released with version 2.3 of Enterprise Developer or
Visual COBOL 2.3 or with earlier versions supported the use of the "MFOLECL_NO_THREAD_INIT"
environment variable. Using this variable, you could disable the default OLE Class Library COM
threading initialization. This helped avoid issues that could manifest as hangs and crashes, especially
on Microsoft's Windows 8.x or 10 and with applications that are a hybrid between Dialog System, OLE
class library and .NET elements - see http://community.microfocus.com/microfocus/cobol/
visual_cobol/w/knowledge_base/20715.exception-occurs-when-native-dialog-system-program-calls-
managed-winform.aspx.

In the version of the Micro Focus Compatibility AddPack released with Enterprise Developer 2.3.1 or
Visual COBOL 2.3.1, this environment variable is now enabled by default and no longer needs to be set
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exclusively. To restore the previous behavior, use a new environment variable,
MFOLECL_THREAD_INIT, and set it to Yes.

2848875 (1102920)

Editor Writing Assistance

Back to the list

• IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.

• Pressing TAB in the Visual Studio editor now always inserts the highlighted item in the IntelliSense list
of suggestions.

Enterprise Server

Back to the list

• In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for IO. This has been fixed. In addition, the '-oo' (and the
synonymous '-o ') option of the casfile command has been deprecated. If '-oo' is used, you will now
receive a return code 4 (warning). Instead of '-oo', you need to use the '-ooi' option (open immediate). If
-oo is used with a region configured for VSAM shareoption use, the '-ooi' option is now forced.

2839272 (1101672)
• When using an external security manager to secure a region, the EXEC CICS START TRANSID API

now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.

2835112 (1101201)

IBM Language Environment for OS/390 & VM Support

Back to the list

• When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.

2841220 (1101955)

JCL Support

Back to the list

• The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.

2834206 (1101079)
• Under Enterprise Server and Enterprise Server for .NET, flushing an active job previously resulted in all

associated spool records for the job being deleted, but left the job running. A subsequent attempt to kill
the running job using casout/seeout failed due to the job spool record no longer existing. This change
causes the flush request to fail if the job is active. You must kill the active job first before attempting to
flush it.

• The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.

2698700 (1094266)
• REXX can now be executed in VSE via IKJEFT01 and IRXJCL using in-stream data.

2831984 (1100883)

Significant Changes in Behavior or Usage | 15



Run-Time System

Back to the list

• The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)
• Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE

class condition tests:

• IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

• IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.

• IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.

When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

Back to the list

• The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
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you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

• Run a DSN bind against the customer database. Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

This is a one-time only change to the database.

2843818 (1102248)

SQL Option for DB2

Back to the list

• Spurious errors were sometimes returned while querying using an ALIAS.

2830383 (1100609)
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Compiler

• In .NET projects that include multiple COBOL programs, the following sequence of programs can cause
the Compiler to crash:

• one or more programs that use COBOL file handling;
• a program that does a platform invoke to a native COBOL program;
• another program that also uses file handling.

Debugging

• When debugging Object COBOL programs, it is not possible to step into methods if the Visual Studio
Autos window is enabled.

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

IDE

• When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.

• Replace All does not work inside the Expanded Copybook View
• For copybooks with file extensions that are not traditionally associated with COBOL you must first add

the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

Linking

• Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
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for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Micro Focus Rumba

• On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

PL/I Support

• The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

• Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• CICS BMS Compiler
• CICS Support
• Code Analysis
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Debugging
• Documentation
• Editor Writing Assistance
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• IBM Language Environment for OS/390 & VM Support
• IDE
• IMS Support
• Integrated Preprocessor
• JCL Support
• Mainframe Access
• MFIO
• Micro Focus Common Client
• Micro Focus Directory Server
• Monitoring and Management
• PL/I Support
• Run-Time System
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.

2848637 (1102857)

Assembler Support

Back to the list
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• The DCB macro requires the DSORG= parameter in order to be more compatible with the mainframe.
This parameter has now been added to the Assembler sample programs PGASM04.mlc and
qsamex4.mlc in the Mainframe\Assembler\Classic\QSAM directory in the installation location of the
samples so that these files now assemble without any errors.

CICS BMS Compiler

Back to the list

• A new menu item, Customize IDE, on the Options menu of the BMS Painter utility enables you to
specify your preferences for a font face and font size of the text within the BMS Screen Painter and in
the Output window.

2835960 (1101266)

CICS Support

Back to the list

• Some issues in COBOL Web services and CICS COMMAREA-based web service environments when
EXCI was involved have been fixed. Previously, an ADPL abend was issued when a CICS program
executed an EXEC CICS SYNCPOINT in a CICS COMMAREA-based web service environment. This
has been fixed.

2848968 (1103075)
• When using ISC, ADPL could abend and the client terminated the transaction after changes introduced

by CWS work for LINK without SYNCONRETURN. Enterprise Server now allows the commit to take
place when it receives the end of a conversation and when dfhzcsmi is issuing the commit.

2848069 (617536)
• When ES_XA_RECONNECT is set to true and a number of retries is defined for

ES_XA_nnnn_NB_RETRIES (where nnnn is the XAID), the number of retries was not being checked,
and the XA switch was disabled immediately after a connection issue occurred. The value defined in
ES_XA_nnnn_NB_RETRIES is now honored and, when a connection issue occurs, the switch is not
disabled until after the connection has been attempted for the number of retries.

2843692 (1102209)
• Previously, the product did not identify PL/I programs as such and defaulted to ASCII. PL/I program are

now correctly identified as such and use the API-CODESET value that has been set by PL/I in the
CICS-API control block.

2841424 (1102109)

• An ENQ taken for a write-lock when writing to a recoverable TQD was not released at the end of a task.

2849271 (1102960)
• When you start a region, there is no longer a delay of one second per printer when the printers are

installed.

2847778 (1102784)
• CASPRT now calls the casmguex exit so that the CASCL0020I message can be suppressed from the

console.log file.

2847778 (1102785)
• A problem in the dfhgglbl module when a SPOOL process was active could cause a CICS process

cassplcp to fail to start with a run-time system error 114.

2840334 (1101859)
• Previously, the PROTECT option was not recognized when using START/PROTECT with TRANCLASS.

2832905 (1100929)
• When using mirror transactions, if a resource has browse placeholders or is recoverable, or the lock has

been acquired, a mirror transaction becomes a long-running mirror and does not end until the issuing
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transaction ends the logical unit of work - on SYNCPOINT or RETURN. Any resources that the mirror
has acquired are freed when the initiating transaction issues the appropriate command to free them.
Previously, mirror transactions were only released on RETURN. They are now also released on
SYNCPOINT.

2829652 (1100859)
• When installing a terminal that was not in use, an incorrect flag was checked. An error message

"CASRD0025E 3270 Terminal entry xxxx is out of service or it is in use" was displayed.

2821671 (1099558)
• Previously, when using TRANCLASS, if a TSQ was deleted in one thread while another thread was

trying to read the queue at the same time, Enterprise Server returned an ITEMERR error instead of
QIDERR because the queue had been deleted.

2819309 (1099471)

• A problem adding a new startup group on the casrdo97 startup list ESMAC page immediately after
deleting a group on the same page has now been corrected.

2850524 (1103106)
• When sending a response back, the product now escapes any HTML sensitive characters in order to

avoid an XSS scripting vulnerability.

2846631 (1102678)

• The behavior of non-facility transactions was too silent. Messages are now being sent to the console
about transaction attach failures. The message KC0041 is now sent to the console for asra abends.

2845530 (1102445)

• Performing a phasein on an active program could corrupt the local storage chain for the SEP which was
running that program. A Run-Time System error could occur.

2846132 (1102972)
• The casfile -ooi option failed with an RTS114 error when opening a CICS FCT of the Alt Index type.

2845760 (1102598)

Code Analysis

Back to the list

• The GO TO statement in the analysis result now has a valid sequence line.
• Handling for TRY-CATCH-FINALLY code block has been implemented. An issue with Level 78 constant

declared in linkage section has been fixed.

Common Communications Interface

Back to the list

• Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server

Back to the list

• The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.

2847439 (1102743)
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Compiler

Back to the list

• The expression 'instance of type com.microfocus.cobol.program.Reference' (or the .NET equivalent) no
longer produces unverifiable code in either JVM COBOL or .NET COBOL.

2844614 (1102378)
• OSVS report writer programs now compile as expected.

2848192 (1102831)
• SQL programs containing procedural $SET CONSTANT directives now compile as expected.

2847029 (1102768)
• Passing variable length groups to a user defined function now produces correct object code, which

executes as expected.

2845100 (1102408)
• An implicit definition of a VALUE OF FILE-ID, that is, when the program does not declare the data-name

specified in the VALUE OF FILE-ID clause, has been fixed. Previously, the implicit definition was being
made external when it should not have been.

2844151 (1102278)
• COPY statements that span multiple lines no longer stop REPLACE operations from working as

expected.

2843367 (1102672)
• A REPLACE statement that acts upon a literal containing a continuation character, where the literal also

contains quotation marks that start and end on different lines, now compiles as expected.

2841444 (1102573)
• COPY REPLACING now correctly affects a REPLACE statement, even if a REPLACE statement is

already active.

2841281 (1101930)
• COBOL applications using ActiveX controls need to add the -A option to the OOCTRL Compiler

directive in order to invoke methods in the ActiveX control.

2840671 (1101874)
• In the execution of an XML GENERATE statement, the '&' character is now replaced as expected, even

when the associated field is numeric.

2839493 (1101911)
• Warning message "COBCH0990W No period following EXEC SQL INCLUDE END-EXEC. DB2

coprocessor will fail" is now restricted to mainframe dialects only.

2833943 (1101053)
• Alphanumeric ACCEPT statements that specify the CONVERT phrase, under RM(ANSI), now work as

expected.

2833548 (1100998)
• A DBCS name specified as an EXTERNAL ASSIGN name in a SELECT statement is now processed as

expected.

2833547 (1100996)
• A DISPLAY of a national literal now executes as expected.

2833546 (1100995)
• A DISPLAY of the result of the DISPLAY-OF intrinsic function with a national literal argument now

executes as expected.

2833544 (1100994)
• The HOSTRW directive no longer truncates Report Writer files when there is no RECORD CONTAINS

clause in the FD for the report file.
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2826147 (1100638)
• An EXEC CICS statement that references a non-unique paragraph name (but unique within that

section) now compiles as expected.

2816510 (1098877)
• A program compiled with a mainframe dialect that contains a source line with non-ASCII characters in

Area C no longer incorrectly receives the flag message "COBCH1082S Source line is too long".

2809384 (1097885)
• An ALTER statement on a paragraph defined in a previous section, which also had an ALTER statement

on that paragraph name, now executes as expected.

2514516 (1079210)
• The informational message "COBCH1210 COMP processed as DISPLAY (future occurrences not

indicated)" has been fixed so that it is produced based on the COMP directive setting and not the
DIALECT setting.

• A COBRT114 error in generated code on Itanium platforms, for extremely large programs (> 2^24 bytes)
has been fixed.

2844642 (1102395)
• A link error "fatal error LNK1190" when compiling to an executable on 64 bit Windows no longer occurs.

2843600 (1102215)
• A bug in generated code on Intel-x86 32-bit platforms, when generated with opt (4), which caused an

infinite loop, has been fixed. The bug affected SORT on a table that has an "occurs ... depending on ..."
clause.

• A bug during compilation with the OPT(3) directive set, where a loop variable could contain an incorrect
value after a PERFORM UNTIL loop, has been fixed.

• An error no longer occurs as the result of using the 'AS template-1' phrase within an INVOKE
statement. Previously, this could generate a COBRT240 runtime error.

• On little-endian 64-bit platforms, such as Windows 64-bit or Linux x86 64-bit, a bug could occur with the
following code: add 1 to var-a add 1 to var-a giving var-b where var-a is a comp or comp-x item less
than 8 bytes in size. The result of the bug was that the wrong value was stored in var-b. This bug has
been fixed.

• In managed code, a contained class with the SHARING PARENT phrase is now able to access PIC X
and other native COBOL data in the object section of the containing class. Previously, this did not
produce a syntax error but caused the generation of bad code.

2851402 (1103200)
• An error during compilation on the code generated by Visual Studio when adding a user control to a

WinForm has been fixed.

2846867 (1102664)
• A named parameter targeting a MicroFocus.COBOL.Program.Reference object no longer causes the

generation of bad code and system errors.

2844673 (1102345)
• An XML PARSE or XML GENERATE statement with a GO TO in the ON EXCEPTION clause now

compiles as expected for managed code.

2844550 (1102309)
• The debugger now executes as expected when a WPF application includes a nested class.

2844416 (1102294)
• Previously, when a file was declared in the instance data of a class (e.g. within OBJECT/END OBJECT

headers), and the file did not declare a status field, an attempt to add the class to a run unit could fail.
This has been resolved.

2844146 (1102639)
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• The compiler no longer produces an incorrect error message in cases where a property expression is
used as an argument to an 'old-style' invoke statement. A possible work-around also existed when
receiving the error, which was to replace the old-style syntax: invoke my-object "MethodName" using
(obj::Property1) with the new: invoke my-object::MethodName(obj::Property1).

2843344 (1102232)
• When compiling for JVM COBOL with the OUTDD directive, a DISPLAY statement with more than one

operand, or a DISPLAY WITH NO ADVANCING statement no longer causes the generation of illegal
code, and a run-time error when the class is loaded.

2842263 (1102086)
• The DIVIDE statement with the REMAINDER phrase now gives correct results under

DIALECT"ENTCOBOL".

2841964 (1102206)
• Errors encountered while attempting to resolve type references are now included in the count of errors

printed at the end of the compilation listing.

2841074 (1101923)
• Programs using the IBMCOMP directive no longer crash during 64-bit compilation when the program

contains an arithmetic expression (-1 * long-numeric), where long-numeric is declared as pic s9(18)
comp.

2834718 (1101195)
• In versions of the product before 2.2, it was permissible to define a level 88 condition on a data item in

the linkage section of an interface method definition. Such level 88 items were simply ignored during the
generation of the code for the interface. In version 2.2.1, this syntax started to produce an error. We
have now reverted to the previous behavior, where these level 88 items are permitted, but ignored.

2833633 (1101111)

Data Tools

Back to the list

• When filtering records, it is based on the selected encoding when the Filter dialog box was opened.
Previously, the filter was only using ANSI encoding.

• The editing caret no longer disappears when in Edit mode.
• The Hex View is now displayed when you click Toggle Hex after opening a data file that does not

contain a layout.
• Deleting the last record in a sequential fixed-block file or a line sequential file no longer produces an

error message or crashes the editor.

• When copying and pasting records, the record length for fixed block files is no longer resized.

2833640 (1101732)

Debugging

Back to the list

• On Windows, the CBL_DEBUG_START routine will now use the COBANIMSRV environment variable
as the identifier, if the identifier passed in is NULL. This also means that cross-session animation now
works as per the UNIX environment.

Documentation

Back to the list

• The documentation has been updated to include the "ra.xml file" topic describing the contents of the
ra.xml file, which includes a list of properties that configure your CICS resource adapter.
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2828775 (1101075)
• The topic "DEFINE CLUSTER" in the product help has updated information about the RECORDSIZE

parameter and the file that will be created.

2830878 (1100668)
• The instructions in the product help on how to run .NET COBOL applications from a network server

have been updated. These now include details about how to make the appropriate .NET run-time
assemblies available to your applications and how to elevate the security permissions levels of the
applications.

2826751 (1100478)
• When handling XML files, after a successful WRITE action, the size of the XML file written is returned

as the status code.

2587541 (1085484)
• When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This

switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.

• An Enterprise Server error message has been added to the help pages for CASKC0048, process soft-
killed failed and was hard-killed.

2846350 (1102574)
• The ldpli topics have been updated to include information about native ld options.

2840325 (1101829)
• The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

2836105 (1101281)
• libmf.so has been renamed to libmfpli.so/libmfpliz.so in the Open PL/I User's Guide.

2822746 (1099744)

• The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

2848869 (1102896)
• In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been

changed from 48 to 60.

2844479 (1102300)
• The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.

2844210 (1102719)
• Additional information added to the help pages for the audit event codes emitted by the External

Security Facility (ESF) and Micro Focus Directory Server (MFDS).

2842807 (1102120)
• If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using

a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.

2837405 (1101440)
• The product documentation has been updated to include the topic "IMS and GSAM Databases" located

in the table of contents under Programming > IMS Support.

2789025 (608922)

• Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.

2839572 (1101835)
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Editor Writing Assistance

Back to the list

• IntelliSense (in Visual Studio) and Content Assist (Eclipse) no longer offer verbs within EXEC blocks.
The END-EXEC statement is offered instead.

• The IntelliSense suggestions now include the attributes for any reference, output or returning
parameters that are explicitly declared in the linkage section.

• An issue where IntelliSense (Visual Studio) and Content Assist (Eclipse) offered Sort/Merge items
where only file items were valid has been resolved.

(616206)
• Intellisense (Visual Studio) and Content Assist (Eclipse) now only offer suggestions for types which are

suitable to the context. For example, the suggestions for a CATCH phrase only include exception types
and the suggestions after NEW only include constructable types.

• In Visual Studio, IntelliSense is now only triggered when typing characters which are expected to form a
part of a valid COBOL word.

• Intellisense (Visual Studio) and Content Assist (Eclipse) now offer members of the current type when
there is no qualification using "SELF::" or "SUPER::".

• Intellisense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for READY TRACE and
RESET TRACE.

• The Intellisense (Visual Studio) and Content Assist (Eclipse) suggestions no longer include multiple
imported types with the same short names.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for specifying array
types (OCCURS) in managed COBOL.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer all relevant data for EXHIBIT
statements.

• IntelliSense (in Visual Studio) and Content Assist (in Eclipse) now correctly handle the automatic import
of the namespace (and any nested types) from the current type.

• Sometimes, the IntelliSense suggestions after the SIZE OF phrase did not include the available local
arrays.

• IntelliSense now works for #-escaped identifiers.
• In Visual Studio, IntelliSense now always inserts member names in the same case as they were

declared regardless of the IDE preferences for the case of data items.
• Previously, when a type name was selected in IntelliSense list, the namespace separator dot could

incorrectly get removed.
• Condition-value items are now correctly accepted as complete conditional expressions.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) no longer offer completion suggestions outside

of their proper scope.
• IntelliSense now offers suggestions for method arguments that contain arithmetic expressions.
• Overridden generic methods no longer get listed multiple times in the IntelliSense suggestions.
• You no longer receive IntelliSense suggestions when you start typing in the middle of a word.
• IntelliSense proposals now correctly replace unquoted copybook names in the editor.
• In managed COBOL programs without headers, the IntelliSense (Visual Studio) and Content Assist

(Eclipse) lists of proposals now include variables.

Enterprise Server

Back to the list

• The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.

2847684 (1103145)
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• Cancelling a job sends a sigterm signal indicating that the process needs to terminate. If the process
did not complete, Enterprise Server would then send a sigterm again instead of sending a sigkill signal.
A sigkill signal is now correctly sent in such situations.

2845534 (1103261)
• When processing a WSBIND that contain nested occurs levels, the group level is now correctly

maintained.

2844738 (1102697)
• XA transactions will now end when an ECI request fails with PGMIDERR.

2843668 (1102276)
• The order in which user privileges are checked when accessing cataloged files has changed. First, a

check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.

2842162 (1102048)
• Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an

abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.

2841974 (1102004)
• When the targetService option was enabled for the JMS Invoke Webservice, no response was returned

to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.

2841602 (1101959)
• casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get

deleted when using Delete from the ESMAC page.

2839657 (1101706)
• Mainframe Subsystem support for the EZ Sockets APIs in Enterprise Server now includes the

SO_RCVTIMEO and SO_SNDTIMEO socket options. Support for these is limited to the options
provided by the underlying Operating System.

2833375 (1101002)
• A Run-Time System error 114 no longer occurs when a GET request is received.

2825851 (1100157)
• You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already

using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

2821228 (1099658)
• You no longer receive a memory leak in cassi processes when using the Micro Focus External Call

Interface.

• If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.

2836688 (1101388)

• The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").

2854402 (1103604)
• When using LDAP-based security immediately after installing Enterprise Server, with the sample access

rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.
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2838380 (1101547)
• The LISTREFERENCES command now works correctly when the resource class names use special

characters.
• When using a JES initiator in the GLM, the locks could not be released properly if a job was running in

that initiator while another process was waiting for the locks.

2838871 (1101612)

Enterprise Server for .NET

Back to the list

• Trying to start regions under Enterprise Server for .NET failed when using an SQL Server 2016
database instance.

• Cached HSF events were being lost if an Enterprise Server for .NET system was shut down or recycled.

File Handling

Back to the list

• OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.

2849233 (1102953)
• If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified

at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.

2842825 (1102218)
• Rebuild now correctly processes the key structure defined through an options file.

2837028 (1101412)
• Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg

configuration file (e.g. [file.dat]).

2832386 (1100932)

• Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).

2837756 (615857)
• Rebuild now allows the case where "9" is specified after ":"

2836782 (1101437)

• SEP corruption no longer occurs when running a SORT operation.

2843320 (1102182)
• MFSORT now returns a 9/018 error when an incorrect record length is specified.

2834614 (1101131)

IBM Language Environment for OS/390 & VM Support

Back to the list

• The Language Environment jobs which are run after an abend now runs correctly.

2847262 (1102897)
• A problem with multiple calls to MFLEINIT without subsequent process termination causing exhaustion

of virtual file space has been corrected.

2829308 (1101231)
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IDE

Back to the list

• When examining the value of object expressions in Visual Studio, the description of the class is now
available and the instance data can be examined.

2842968 (1102127)
• Hovering the mouse over a data item in the Code Definition window in Visual Studio could result in

receiving an exception.

2841885 (1102449)
• By default, pressing Space no longer inserts the highlighted item in the IntelliSense suggestions. You

can change this behavior from the Insertion page in Tools > Options > Text Editor > Micro Focus
COBOL > IntelliSense.

• After splitting an editor window, hovering a data item in one of the panes of the editor could cause the
IDE to crash.

• Previously, if you had a COBOL program opened in the editor and that program did not belong to any of
the projects in your current solution, using the Start Debugging context menu would not start debugging
the StartUp project of the solution.

• Stepping into a debuggable native code program which is not part of a project could cause the Visual
Studio IDE to crash.

• When debugging .NET COBOL code, groups that are not referenced might be optimized for
performance by the Compiler. In such cases, when querying groups in the debugger, the length of the
group and the contained group data are not shown in the debugger by default. To ensure you see this
data, you need to compile the code with the NOILOPTIMIZEDATA Compiler directive.

• Native COBOL projects that contain programs with names that include non-ASCII characters now build
successfully.

• Debugger data tips are now displayed correctly in the expanded copybook view in the editor.
• The COBOL editor in Visual Studio now colorizes floating point numeric literals.
• HotFix 1 of Visual COBOL 2.3 for Visual Studio 2015 and Enterprise Developer 2.3 for Visual Studio

2015 provides support for version 2.7 of the Azure Tools for Visual Studio.
• A performance problem that occurred when modifying the Output path property for Mainframe

Subsystem Application projects has been fixed.
• When creating a new ASP.NET Web Application project, the login page is now displayed correctly.

IMS Support

Back to the list

• The IMS database editor could not access a database directly. The editor was only functional when
editing a database using a PCB in a PSB.

2849835 (1103025)
• Direct access to a secondary index database that uses system generated /SX fields no longer fails

when the primary database is compiled using the SXRBAFORMAT"2" directive.

2845024 (1102464)
• Read only access to an IMS database from a batch application failed after IMS DB had performed an

automatic backward recovery. Restarting the server corrected this condition.

2844983 (1102431)
• A BMP program using a PSB that specified CMPAT=NO sometimes returned incorrect results to a DB

call.

2844084 (1102463)
• Batch IMS applications that access IMS database data directly can override ES_IMSDAT and access

this data in different folder locations.

2833328 (1100981)
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• A DBD from a DOS/VS environment that made use of an assumed START= parameter on the SEGM
FIELD statement was previously unsupported. This support requires the IBMPLATFORM=DOSVS
DBDGEN directive.

• A protection fault resulted when attempting to load an IMS database using MFDAS when the ACB was
missing.

• The Admin SEP no longer abends with an RTS 114 error when starting an MPR with an MPR name.

2845871 (1102500)

• The attribute byte for a dynamic attribute was being improperly converted. This has been corrected.

2849654 (1103033)
• The limit of labelled DFLDS and MFLDS has been increased from 500 to 1000 per MFS. This enables

you to use MOD 5 type of screens (24 X 132) which can contain many more fields than the more
common MOD 2 type of screens (24 X 80).

2849190 (1102943)
• The MFS generator has been updated to fix an issue with /FOR Type-5 screens. To apply this fix, you

must regenerate your MFS source files using this release of the product. Also, the device type specified
in the MFS for MOD 5 screens (27 X 132) must be 3270-A7.

2848896 (1102915)
• MFS files with literals of the form "DFLD G'<dbcs characters>',POS=(03,1),LTH=54,ATTR=(PROT)"

were seeing the last byte of the literal clipped in the generated control block and on screen at run time.
This problem has been fixed and all G literals should generate and display correctly.

2848014 (1102773)
• If the trancode is 8 bytes in length and the application does not accept a trailing space as part of the

input message, you must ensure that the trailing space flag is checked in the enterprise server
configuration. In addition, a fix has been made to IMS code that applies to conversational application
when the trancode is less than 8 bytes. When the conversation starts for the very first time, IMS now
strips the trancode out of the input message and puts it in the trancode area of the SPA buffer. The input
message is then shifted to the left by the length of the trancode. Afterwards, the input message is
formatted strictly by the MFS input definitions.

2837836 (1101690)
• If the last output LPAGE is missing its COND statement, an error message is considered unnecessary

and is no longer issued. You will still receive an error, if the COND statement is missing from any output
LPAGE that is not the last.

2833816 (1101032)
• The NULL FILL value in the input field (pfkey) is now correctly recognized and NULL FILL characters

are stripped out from the input message and the message is compressed. When the field following the
field (pfkey) with NULL fill characters is the trancode field, MFS now invokes the application associated
with the trancode. Katakana characters are not displayed correctly. To work around this issue, you need
to set PCOMM or RUMBA codeset 930 which is compatible with MFCODESET=9122.

2833225 (1100955)

• The APARM returned to the AIBTDLI INQY ENVIRON call is now restored with each execution of the
INQY call.

2846411 (1102605)

• A previous update had updated the behavior of a CHNG call issued from an OTMA- or IMS Connect-
submitted transaction such that the destination was assumed to be the OTMA client. In some
circumstances, the previous behavior of assuming a non-OMTA client is desirable. To use the previous
behavior, set the ES_IMS_BYPASS_OTMA_DEST_RES Enterprise Server environment variable to
ES_IMS_BYPASS_OTMA_DEST_RES=y.

2835781 (1101595)
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• For servers using external security, IMS printers sometimes failed to reconnect after disconnecting.

2835352 (1101479)

• The IMS Database Utility could not load an IMS database when a special character such as "@", "#" or
"$" was used in the first position of the segment name definition (DBD SEGM NAME=).

2848521 (1102845)
• On Red Hat Linux, incorrect results were returned to an EXECDLI application program. The WHERE

clause of a GET call was incorrectly negated.

2845172 (1102400)

Integrated Preprocessor

Back to the list

• Programs with EXEC SQL INCLUDE statements that have a trailing period that is not immediately
following the END-EXEC now compile as expected with the COBSQL preprocessor.

2844222 (1102486)
• A user preprocessor which calls directly the 'CP' system preprocessor now behaves as expected during

the syntax checking of source files you are editing.

JCL Support

Back to the list

• MFDB2UNL did not process the SELECT statement correctly if it started in a column other than 1.

2845002 (1102407)
• An issue that caused SSTM and JCL-enabled regions to hang when starting has been resolved.

2849994 (1103031)
• IDCAMS ALTER now supports renaming of physical files if they have an environment variable specified

in their paths. To enable this behavior, you must set the environment variable MF_PCRENAME_LAX to
'Y'.

2848692 (1102898)
• When assigning a new job number, records from past jobs with the same job number were erroneously

included in the job listing.

2847426 (1102709)
• The spool housekeeping utility, mvssplhk, now does not delete active CICS SSTM jobs. It is possible to

remove expired SYSOUT datasets from the jobs.

2847421 (1102708)
• It is now possible to include key offset and length information when replacing cataloged VSAM index

and data elements using MVSCATPB.

2846554 (1102608)
• MVSSPLHK has been updated so you no longer receive a duplicate error when the CATALOG is

archived.

2846100 (1102623)
• Using the MFCATXML or the MVSCATPB REPL function to replace a catalog no longer causes the

enterprise server to hang.

2846018 (1102524)
• When loading catalog records from an XML file using MFCATXML, the pds extensions from earlier

records are no longer carried forward.

2845761 (1102519)
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• Quoted values are now supported for the PRTQUEUE OUTPUT statement.

2844696 (1102356)
• Job outputs are now correctly being sent to the printer exit when there is a heavy JES workload.

2844053 (1102254)
• The following DATACLAS parameters are now supported: AVREC/AVGREC, DSORG and RECORG.

2842497 (1102064)
• A DD referback was incorrectly using the catalog properties of the file referred to and not just those

DCB parameters defined on the referred to DD card.

2842304 (1102044)
• The MVSSPLHK housekeeping process now correctly removes JOB99999.

2842083 (1102018)
• The Micro Focus emulation of ICETOOLS no longer incorrectly processes the RDW directive twice.

Previously, this would lead to lost data.

2841136 (1101894)
• A JESYSMSG for a reprinted job now correctly displays in the JES Spool>Printed queue.

2840462 (1101867)
• The change date in the catalog was not being updated for concatenated datasets. The catalog now

shows the time/date for the end of step processing for all concatenated datasets.

2840128 (1101779)
• When the first job run uses 2 programs that both open the same file, the Shareoption Manager no

longer incorrectly returns an access denied message.

2839737 (1101834)
• Where appropriate, LEX files are now correctly removed during the MVSSPLHK spool housekeeping

process. Previously, if the ES_ALLOC_OVERRIDE variable specified a different location to the
MFALLOC_LOC variable these files could be missed. Also, the message for casspool record type 16
records in SYSPRINT now displays correctly.

2839699 (1101778)
• A SORT operation on a Variable Block file where INREC processes are specified no longer incorrectly

changes all records to Fixed Block.

2839561 (1101737)
• The correct next bias number for GDGs will be used when existing biases are removed.

2837967 (1102225)
• The casout /g<jobnum> command now works correctly when ES_JESYSMSG_OUTPUT=Y is set.

2837860 (1101512)
• The IDCAMS REPRO command generates a file status 35 if the physical file of a cataloged input file

does not exist.

2837596 (1101509)
• A problem where incorrect HSF stats were being reported for the SSTM job has been corrected.

2837158 (1101448)
• If a printer exit requests removal of the JESYSMSG (JCL Job log), any OUTPUT statement and

SUBSYS information is retained. If restart is enabled, the job log and other job files required for
restarting are not removed.

2836023 (1101573)
• When copying SYSUT1 to SYSUT2 (using IEBGENER), where SYSUT2 is a spool file with no RECFM

supplied in the JCL, the SYSUT1 RECFM is now used if it is valid. Previously, it was only being used
when set to "F".

2834419 (1101200)
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• It is now possible to scroll backwards from the first spool display page to the last one. If the spool file is
rather big, however, scrolling could be slow as all the spool records need to be processed before the
last page is displayed. This is the expected behavior.

2833812 (1101030)
• You no longer receive a file locked error when JCL accesses CICS shared files.

2833284 (1101010)
• JCL validation no longer fails an OUTPUT statement that has no parameters.

2833175 (1100991)
• An error in the JCL scanner that reported a JCL error when scanning a job that contained a NULL IF

statement has been corrected.

2832582 (1101015)
• The JCL COND CODE for PRINTED queue records was displayed with invalid characters.

2831180 (1100784)
• A problem that resulted in receiving an RTS 114 error when clicking on the REPLY button has been

fixed. This would happen if you were using dynamic debugging to debug a JCL job and clicked "Stop
Debugging" while the job was still waiting for an input from the user.

2828547 (1100819)
• MVSSPLHK now scans the LEX file directory for orphan LEX files, and deletes them if they are older

than the max retain period.

2826722 (1100693)
• Using DSNRLI with multiple XA switch modules and performing a 'SWITCH-TO' action to a XA resource

with a name shorter than the previous resource, caused an error with a return code of 4 and a reason
code X'00C12205'. The DSNRLI module now correctly performs 'SWITCH-TO' actions.

• Enterprise Developer now provides a new utility, MFJPTPCH, that emulates the IEBPTPCH (Print-
Punch) utility.

• This release provides a new environment variable, MVSSPOOLDIR, which can be used to direct spool
control files to a location which is different to the location of the main catalog file.

2839703 (1101713)
• It is now possible to configure multiple user catalogs for Enterprise Server.

2514366 (1101309)

• The SETPARM statement can now be used with the IF statement. For example: SETPARM pppp=xxxx
IF pppp=xxxx

2820858 (1099472)

Mainframe Access

Back to the list

• In the shipped MFAAS JCL proc required for the Changeman dependent server, a DD CEEOPTS points
at a member in the Mainframe Access parameter library. Because the CHM support changes the ACEE
task to that of the user, the user must have read access Mainframe Access MFA parameter library. If
this is not acceptable, to work around this issue, you need to:

1. Remove the CEEOPTS statement. The EXEC PARM field can be changed to
PARM='TRAP(OFF,NOSPIE)/', if required.

2. Move the CEEOPTS member to a world-readable library.

MFIO

Back to the list
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• Enterprise Developer now includes the SourceConnect functionality.

2807623 (1098289)

Micro Focus Common Client

Back to the list

• COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server

Back to the list

• Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

2846804 (1102971)
• Enterprise Server instance startup performance has been improved, particularly when the Enterprise

Server Administration GUI has been configured to use SSL.

2837359 (1101501)
• Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if

configured to use an SSL browser connection.

2834446 (1101342)
• The Enterprise Server user id no longer needs to have security administration access permissions to

start an Enterprise Server instance if external security is specified.

Monitoring and Management

Back to the list

• The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .

2830110 (1100895)

PL/I Support

Back to the list

• A problem when using function names without parentheses in a SELECT statement has been fixed.

2850897 (1103138)
• A memory leak in IF statements with the ANY built-in function on a CONTROLLED array has been

fixed.

2847413 (1102718)
• The -fb7asfb15 compile-time option is now recognized by mfplx.

2846327 (1102571)
• The maximum number of PCB parameters under the -systemims compile-time option is now a

maximum of 99.

2846066 (1102523)
• A problem with named constants of type BIT has been fixed.

2843898 (1102375)
• A non-zero scale-factor supplied to the DIVIDE built-in for FIXED BINARY arguments is now diagnosed

with an E-level diagnostic stating that an integer result will be produced. (Note: scaled fixed binary
arithmetic is not supported.)

2842326 (1102119)
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• A code generator issue causing a runtime SEGV has been fixed.

2842145 (1102029)
• A problem with the -zalign option causing message MFPLI02000A has been fixed.

2842061 (1102034)
• A problem when a named constant of type BIT is declared with VALUE ('') has been fixed.

2841654 (1102010)
• A problem when using function names without parentheses in a SELECT statement has been fixed.

2841422 (1101968)
• A problem when specifying alternate currency symbols has been fixed.

2840770 (1101853)
• A problem with the -graphic option when used with mfplx and -sql support has been fixed.

2838680 (1101581)
• A problem with automatic initialization has been fixed.

2837702 (1101488)
• A problem with initial repetition factors not working for the GRAPHIC and WIDECHAR data types has

been fixed.

2830665 (1100640)
• A problem with the RANDOM built-in function has been fixed.

2830364 (1100611)

• Previously, when using the non-standard option -margins 1,72 and the macro preprocessor (or -cics),
additional blank lines were infused into the source code causing the debugger line numbers to be off
and the stepping in the debugger to appear nonsensical. This no longer happens.

2835663 (1101366)
• Previously, a CICS program invoked via an EXEC CICS LINK and compiled in EBCDIC was not

generating a proper notification of the load of the shared object. This no longer occurs.

2834253 (1101339)

• Previously, if using a hex literal constant that used PL/I continuation rules for -margins 2,72, an infinite
loop would occur in the macro preprocessor. This no longer occurs.

2852567 (1103328)
• When using the -incafter and -mvs macro preprocessor options compiling using mfplx, the compiler

erroneously put the %INCLUDE in column 1 before the %IGNOREMARGINS directive.

2844255 (1102268)
• Previously, if debugging an application that contained two EXEC CICS statements that appeared

consecutively with no intervening blank lines, upon stepping in the debugger, the debugger would jump
to the middle of the second CICS statement before resuming execution at the proper point on the next
non-CICS statement.

2842819 (1102108)

• Previously if the DAYS() built-in function was used without the optional "Pattern" parameter, a trap
occurred because the "default" pattern of 'YYYYMMDDHHMISS999' was not supplied to the underlying
routines. This has now been fixed.

2849349 (1103295)
• Previously, if using the CODEWATCH notifications and a PUT EDIT triggered a file condition such as

ENDPAGE, the format chain associated with the PUT EDIT statement was not correctly processed upon
resuming after the notification. This has now been fixed.

2842068 (1102012)
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• A problem with concatenation of GRAPHIC strings has been fixed.

2840750 (1101850)
• Previously a KEY condition was incorrectly raised if a KEY(d) read was issued against a VSAM file

which had one or more alternate indexes defined. This has now been fixed.

2838613 (1101607)
• The PL/I preprocessor and DB2 pre-compiler didn't process group variables with SQL TYPE BLOB in

them properly resulting in wrong output for BLOBs. This has now been fixed.

2842781 (1102815)
• A problem occurring when an illegal argument passed to the HEX built-in function has been corrected.

2833417 (1100982)
• Previously, if a program specified via JCL a RECFM equal to F, FB, FBA, FBS and did not specify an

LRECL but instead depended upon the RECSIZE attribution within the ENVIRONMENT option on the
file declaration, then an UNDEFINEDFILE was incorrectly raised. This no longer occurs.

2838039 (1101528)
• When using the Italian EBCDIC Codeset (0039), compiling with -ebcdic and emitting or consuming PL/I

overpunch characters (R or T) the resulting output was not correctly emitted with the X'C0' and X'D0'
characters respectively.

2836438 (1101375)
• Previously, if writing to a variable length relative record dataset and the buffer used for the record was

less than the maximum record length, storage corruption could potentially occur. This no longer
happens.

• An attempt to read into an automatic variable of a size smaller than that of the largest variable-length
record defined for a file sometimes caused stack corruption.

• Previously, if using the DAYS() built-in function from a program executing under Enterprise Server, the
returned result was incorrect. This no longer occurs.

• Previously, if two EXEC CICS statements sandwiched a multi-line comment without any whitespace or
PL/I statements containing semi-colons, an additional blank line was generated in the MDECK which
resulted in debugging lines being off by one. This no longer occurs.

• Previously, if using the CICS precompiler to compile a filename where the filename's length as specified
exceeded 65 bytes, an erroneous additional %FILE statement was injected on the second macro
preprocessor pass specifying the output file from the CICS precompiler rather than the original source.
This caused a problem for the debugger as the debug information now pointed to a non-existent
temporary file. This no longer occurs.

• Previously, if no "-margins" option was specified, the macro preprocessor wrapped at column 256. It
now wraps at column 1023.

• The TRIM built-in function is now supported as part of the PL/I Macro Language.
• Previously, if using a %REPLACE statement which contained a string with embedded pairs of single or

double quotes to signify that the string literal constant contained a double or single quote, the resulting
%REPLACE wasn't properly re-generated in the output deck. This has now been fixed.

Run-Time System

Back to the list

• If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.

2837230 (1101419)
• 64-bit Windows only, and native generated code only. Programs containing code of the form 01 f

comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".

2836893 (1101465)

Resolved Issues | 37



• Under Enterprise Server, a stateful web service containing CICS code no longer hangs if a runtime
error occurs in a nested link level.

2836252 (1101438)
• When using "mfauditadm -r" on an audit file containing processes that have very long command lines,

the process could terminate early with a memory fault. This has now been resolved.

2832770 (1101000)
• Repeatedly calling and cancelling different programs in different threads could cause the application to

hang. This has now been resolved.

• In the .NET runtime, a managed executable can now be successfully executed using
CBL_EXEC_RUN_UNIT when an explicit .exe extension is specified in the program name.

2845604 (1102669)
• A new library routine, PC_PRINTER_INFO_DOTNET, is now available for .NET COBOL applications. It

enables the access to the .NET Graphics/PageSettings objects.

2845991 (1102545)
• .NET COBOL applications can now use PC_PRINTER_LOAD_BMP more than once without this

causing unexpected exceptions.

2845991 (1102546)
• Applications that use run units created with the MicroFocus.COBOL.RuntimeServices class could leak

memory.

2838583 (1101639)
• The XML I-O preprocessor no longer incorrectly represents some fixed point values in floating point

format.

2837561 (1101473)

SQL: COBSQL

Back to the list

• The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

2850394 (1103086)
• Background parse should now create temporary files with names that differ from the actual build

process.

2843719 (1102613)

HCO for DB2 LUW

Back to the list

• A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.

2846756 (1102646)
• An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted

in invalid host variable. This has now been fixed.

2837674 (1101487)

SQL: HCO for SQL Server

Back to the list

• HCO for SQL Server now supports optimization of DB2 SQL statements by adding SQL Server query
hints, such as OPTION(RECOMPILE), to select, insert, update, and delete statements.
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2837973 (1101513)
• In certain scenarios, OpenESQL incorrectly handled nested subselects.

2837591 (1101469)
• A new SQL compiler directive option, SPCALLLOCAL, is available to transform EXEC SQL CALLs that

invoke stored procedures into COBOL calls that invoke local COBOL subroutines.

2836255 (1101304)
• The SQL(SPCALLLOCAL) compiler directive is now available for use with HCO for SQL Server to

enable simulation of DB2 stored procedure execution and the return of result set locators to the caller.
This can improve performance for some applications and deployment scenarios over the alternative of
deploying DB2 stored procedures as SQL CLR stored procedures.

2835095 (1101181)
• HCO for SQL Server incorrectly converted queries using multiple FETCH FIRST clauses in nested

subselects.

2834305 (1101119)
• The OpenESQL run-time was updated to correctly locate the HCO for SQL Server SQLCode mapping

file under the Visual COBOL/Enterprise Developer products for VS2012.

2832258 (1100963)

• A problem with SQL(CHECK) producing false errors has been fixed when using SQL Server 2012 or
later versions.

2850575 (1103116)
• A problem with HCOSS transformations for IN expressions that use row constructors to TSQL EXISTS

has been fixed.

2844923 (1102580)
• An issue where HCOSS did not correctly recognize some OUTER JOIN clauses has been fixed.

2841819 (1102007)

SQL: OpenESQL

Back to the list

• An overflow problem with host variables of type System.Decimal has been fixed.

2849939 (1103195)
• OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC

in a managed application.

2847268 (1102968)
• A problem with EXEC ADO REBIND CONNECTION has been fixed.

2846426 (1102645)
• In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables

defined with zero (0) length.

2845409 (1102510)
• HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for

SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

2844292 (1102483)
• HCOSS did not fully support DB2 ROW_NUMBER().

2843937 (1102362)
• Using SQL(CHECK) with .NET applications caused an error on Oracle.

2842102 (1102037)
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• The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column
where the field is zero length.

2841149 (1102637)
• The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on

the COBSQLTYPE options list.

2840953 (1101877)
• An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL

errors.

2837717 (1101484)
• HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)

columns.

2832384 (1101169)
• The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when

SQL(ISOLATION) was set.

2797208 (1096456)

• To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.

2850022 (1103058)
• To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct

OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2848402 (1102838)
• When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement

prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).

2847791 (1102782)
• OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL

Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.

2846825 (1102701)
• When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that

included literals containing angle bracket characters has been corrected.

2846226 (1102582)
• A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not

parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

2844399 (1102329)
• The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously

omitted from the drop-down list in the user interface.

2842879 (1102128)
• When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error

occurred when the same cursor was opened and closed multiple times.

2841857 (1102003)
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• The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length
input host variables that used an explicit-length field.

2841721 (1102106)
• A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has

been fixed.

2841508 (616495)
• When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with

embedded spaces.

2839826 (1101752)
• In European locales, Oracle queries failed to return the decimal symbol for floating point results

returned to decimal numeric host variables.

2839066 (1102162)
• OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

2838227 (1101571)
• An HCOSS stored procedure called from multiple locations in either the calling application or in a

nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

2834386 (1101104)
• HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a

stored procedure name in a host variable.

2833755 (1101022)
• OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned

values now correctly represent a 24-hour clock.

2833683 (1101017)
• The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.

2829499 (1102075)
• When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect

TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.

2823577 (1099922)
• The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X

host variables with CHAR and VARCHAR columns.

2806980 (1097582)
• An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now

returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
• OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition

to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2

Back to the list

• The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsql0111e - no from clause specified error".

2850293 (1103073)

• When using an open cursor with constants comparison in an IN () clause, an Sqlcode -1352 error
occurred.

2844111 (1102266)
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• An SQL statement with SELECT caused an XDB with Server Violation error when converting from the
CHARACTER to INTEGER type in the INSERT SQL statement.

2839382 (1101677)
• Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL

scalar function ROUND() function.

2831359 (1101083)

• Exiting SQLWizard processing no longer causes an exception.

2849696 (1103097)
• A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has

been resolved.

2846196 (1102659)
• An issue that resulted in a syntax error when editing tables with decimal data has been resolved.

2840937 (1101960)
• Exporting a table with a reserved word as a column name no longer produces an error X020 if the

quoting types are Apost or Quote.

2806803 (1097559)

• An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.

2840936 (1101868)
• When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing

when loading the XICU40N DLL.

2840147 (1101785)
• An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than

required for input parameter markers.

2818992 (1099256)

XML Support

Back to the list

• PREXML now terminates and returns an error message if there is a problem expanding a copybook.

2472213 (1076394)
• XMLPARSE did not honor the encoding in the XML declaration for output text.

2851343 (1103239)
• XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document

contains an XML declaration.

2837110 (1101424)
• XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.

2822339 (1099692)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2266906 (1066314)
• 2541594 (1081441)
• 2610077 (1087571)
• 2613606 (1088533)
• 2691674 (1093498)
• 2784725 (1095083)
• 2792882 (1102055)
• 2801626 (1097006)
• 2801847 (1097374)
• 2805056 (1097357)
• 2806566 (1097816)
• 2807649 (1097763)
• 2809132 (1097892)
• 2812331 (1098359)
• 2815582 (1099634)
• 2817630 (1101066)
• 2824712 (1100086)
• 2824925 (1099961)
• 2825098 (1100032)
• 2825249 (1101374)
• 2827707 (1100302)
• 2828305 (1100419)
• 2828897 (1100491)
• 2829677 (1100588)
• 2830741 (1100655)
• 2830871 (1100785)
• 2831477 (1100831)
• 2831788 (1100810)
• 2831959 (1100864)
• 2832490 (1100907)
• 2832904 (1100916)
• 2833083 (1101060)
• 2833100 (1101123)

• 2833473 (1101007)
• 2833925 (1101045)
• 2834217 (1101124)
• 2834245 (1101085)
• 2834253 (1101099)
• 2834843 (1101156)
• 2834959 (1101167)
• 2835289 (1101498)
• 2835416 (1101496)
• 2835506 (1101288)
• 2835508 (1101292)
• 2835599 (1101293)
• 2835608 (1101494)
• 2835687 (1101497)
• 2835835 (1101262)
• 2836694 (1101356)
• 2837531 (1101490)
• 2837784 (1101511)
• 2838086 (1101525)
• 2838343 (1101586)
• 2838426 (1101552)
• 2838593 (1101986)
• 2838671 (1101587)
• 2838689 (1102052)
• 2839730 (1101776)
• 2840155 (1101821)
• 2840349 (1101906)
• 2840530 (1101860)
• 2840658 (1101893)
• 2840766 (1101857)
• 2840977 (1102019)
• 2841607 (1101961)
• 2841785 (1101988)

• 2841933 (1102021)
• 2842318 (1102129)
• 2842702 (1102121)
• 2842940 (1102122)
• 2843048 (1102186)
• 2843076 (1102135)
• 2843140 (1102509)
• 2843301 (1102185)
• 2843324 (1102296)
• 2843438 (1102240)
• 2843446 (1102173)
• 2843446 (1102174)
• 2843884 (1102492)
• 2845184 (1102627)
• 2845218 (1102490)
• 2845635 (1102601)
• 2845781 (1102730)
• 2846150 (1102557)
• 2846669 (1102644)
• 2846797 (1102780)
• 2846971 (1103070)
• 2847253 (1102806)
• 2847876 (1102765)
• 2848324 (1103143)
• 2849271 (1103044)
• 2849307 (1102974)
• 2849430 (1103011)
• 2849508 (1102970)
• 2849972 (1103094)
• 2851114 (1103175)
• 2851169 (1103174)
• 2852143 (1103362)
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Installation

Before Installing

Downloading the Product
You can download Enterprise Developer from the Product Updates section of the Micro Focus SupportLine
Web site.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit or 64-bit applications with Enterprise Developer installed on a 64-bit
operating system.

• This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Note:
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• Besides the software listed below, the setup file also installs the 32-bit Java 8 Update 51.
• This product includes OpenSSL version 1.0.1p.

Visual Studio IDE

This product requires Microsoft's Visual Studio.

You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Enterprise Developer for Visual Studio 2012 or 2013):

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)

Microsoft's Visual Studio Express Edition is not supported.

If there is no Visual Studio installed on your machine, the setup file for Enterprise Developer for Visual
Studio 2012 or 2013 will install the Visual Studio Integrated Shell. Alternatively, you can download the
Visual Studio Integrated Shell from the Microsoft Download Center and install it before you install
Enterprise Developer. If you choose to install the Shell, ensure you run the installer to complete the
installation - run vsintshell.enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Enterprise Developer for Visual Studio 2013.

• Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the
Shell has a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not
included in the setup for Enterprise Developer for Visual Studio 2015 and before you start the
installation, ensure that there is an advanced edition of Visual Studio 2015 installed on your
machine.

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.
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• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing
Enterprise Developer on a machine that has no Visual Studio 2013 installed, the setup file installs Visual
Studio 2013 Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's
Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

Database Access - Mainframe Batch Database Tools (MBDTs)

Back to Top

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.
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Availability Feature/Platform 32-bit 64-bit

x86-64 running Windows X X

OpenESQL The MBDTs are OpenESQL applications, and are native code using ODBC. Please see the
Database Access - OpenESQL section for further details.

Testing For this version, the MBDTs were tested with:

• DB2 LUW 10.5
• Oracle 12.1
• SQL Server 2012

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer for Visual Studio , the machine does not have Microsoft Visual
C++ Redistributable Runtime already installed, it is installed as required by Enterprise Developer. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2012, the machine does not have Microsoft
Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2015, the machine does not have Microsoft
Visual C++ 2013 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:
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1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

On UNIX

Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus installer 479 1.91 GB 958 36.5

HP IA Micro Focus installer 866 3.46 GB 1.73 GB 69

System Z
running Red
Hat Linux

Micro Focus installer 390 1.56 GB 780 36

x86-64
running Red
Hat Linux

Micro Focus installer 431 1.72 GB 862 46

SPARC
running
Solaris

Micro Focus installer 492 1.97 GB 984 40

System Z
running SUSE
SLES

Micro Focus installer 394 1.58 GB 788 36

x86-64
running SUSE
SLES

Micro Focus installer 437 1.75 GB 874 46

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Software Requirements for Micro Focus Enterprise Developer Unix
Components
These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• The following operating system libraries must be installed:

Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc-locale-32bit X X

gcc X X

gcc*.i686 X X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

libstdc++-*.i686 X X

gdb* X X X X

elfutils-libelf-** X X X X

libelf-
devel-0.137-8.19
**

X X X X

libelf1-0.137-8.19*
*

X X X X

libelf1-32bit-0.137-
8.19**

X X X X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required for native COBOL and Java
interoperability. The setup file installs Java 8 u51 32-bit. You can download Oracle's Java EE from 
Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:
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• You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Additional Software Requirements for Micro Focus Enterprise
Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

UNIX and Linux Installer Issues

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks.

Installing
Note:

• This version of the product is a full install.
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• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have
an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Run the edvs2012_231.exe file (or edvs2013_23.exe, edvs2015_23.exe) and follow the wizard
instructions to install the prerequisite software and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Micro Focus Enterprise Developer Unix
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.3_update1_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.3_update1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_2.3_update1_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

On Windows

Installing as an Upgrade
• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server

configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2012_231.exe which contains a number of product .msi
files (Windows Installer packages). When run, edvs2012_231.exe performs some initial system checks
then sequentially installs the .msi files.
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Note: The following applies to edvs2013_23.exe when installing the product for Visual Studio 2013.
The following applies to edvs2015_23.exe when installing the product for Visual Studio 2015.

edvs2012_231.exe can take a number of parameters, enabling you to specify a number of different
types of installation:

• Standard Installation

Format:
edvs2012_231.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
edvs2012_231.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
edvs2012_231.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
edvs2012_231.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
edvs2012_231.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2012_231.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

On UNIX
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Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix
Components, so you do not need to uninstall it. There are two options for installing the latest version in this
case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/
EnterpriseDeveloper, by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/EnterpriseDeveloper /opt/microfocus/
EnterpriseDeveloperversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Micro Focus Enterprise Developer Unix Components installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_2.3_update1_platform -installlocation="full path of new 
location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.
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Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

• From the Windows taskbar, click Start > All Programs > Micro Focus Enterprise Developer >
Enterprise Developer for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8, Windows 10, and Windows Server 2012. You
use the Start screen to invoke programs.

To view the documentation installed with your product:

• Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu click
Help > Set Help Preferences > Launch in Help Browser.

For full details of the Visual Studio Help system, see the locally installed Microsoft Help Viewer Help, which
is available from Help menu in the IDE.

Note: On some Windows versions such as Windows 8 or Windows Server 2012, an issue with
Microsoft Help Viewer and Internet Explorer's security being turned on can cause the Help content to
be displayed as raw HTML code. To resolve the issue, you need to turn off the Internet Explorer
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Enhanced Security Configuration (IE ESC) for both administrators and users. Check the Microsoft
Windows help for more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX
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Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.3.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

•
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• Your entitlement for using this product is governed by the Micro Focus End User License

Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.
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If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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